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READ ME FIRST 
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In case you're not familiar with the terminology, 
Read Me First is quite often the name given to a 
computer file that contains important information 
for people to know prior to using an application. 

This section contains some important information to 
help you use this book so we thought we'd start 
with a Read Me First section. 

 

What skills and knowledge 
you will acquire... 

The skills and knowledge acquired in Microsoft Access 2016 - Advanced 
Queries are sufficient to be able to use and operate the software 
effectively. 

What you'll need to know 
before beginning this 
course... 

Microsoft Access 2016 - Advanced Queries assumes little or no 
knowledge of the software. However, it would be beneficial to have a 
general understanding of personal computers and the Windows operating 
system environment. 

 

The objectives of this guide… At the completion of this course you should be able to: 

create simple and effective queries 

create queries based on one or more tables 

create and use parameter queries 

create calculated queries 

create and work with aggregation queries 

create and use a series of action queries 

What you get in a chapter... Each chapter begins with a summary page listing the topics covered in 
that chapter. The chapter then consists of single-page topic sheets 
pertaining to the theme of the chapter. 

What you'll need to have 
before commencing this 
course... 

Many of the topics in this learning guide require you to open an existing 
file with data in it. These files can be obtained from your instructor and 

need the product code for this course which is AccAdvQueries. 

As you work through this 
guide… 

It is strongly recommended that you close all open files, if any, prior to 
commencing each new chapter in this learning guide. Each chapter, 
where relevant, has its own set of exercise files and any from a previous 
chapter are no longer required.  

Where to from here... Have a look at the next page which explains how a topic page works, 
ensure that you have access to the exercise files (see above), and you're 
ready to make a start. 
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The majority of this book comprises single-page 
topic sheets. There are two types of topic sheets: 
task and reference. The layout of both is similar 
– an overview at the top, detail in the centre and 

additional reference (optional) material at the 
bottom. Task sheets contain a Try This Yourself 
step-by-step exercise panel in the detail area as 
shown below. 

 
Topic name 

 
General topic overview provides an introduction to the topic 

 
Try This Yourself (Task-based topic sheets) is a detailed step-by-step practice 
exercise for you to work through. In Reference topic sheets this is usually replaced 
by a box with reference information. 

 
In Task topic sheets screen shots and graphics provide a visual clue as to what 
will happen when you work through the Try This Yourself practice exercise. In 
Reference topic sheets the screen shots and graphics are used to visually 
represent information and concepts. 

 
The For Your Reference (optional) element provides a quick summary of the steps 
required to perform a task. These usually only appear in Task-based topic sheets. 

 
The Handy To Know (optional) element provides additional information such as 
alternate ways of accomplishing a task or further information providing handy tips.  
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2 

3 
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WORKING WITH TOPIC SHEETS 
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CHAPTER 1 CREATING QUERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of how queries work 

 learn how to create a new query design 

 learn how to work with a query 

 learn how to modify a query design 

 learn how to apply record criteria for a query 

 learn how to clear selection criteria 

 learn how to save a query 

 learn how to run queries from the Navigation pane 

 learn how to delete a query from a database file 

 gain an understanding of creating additional queries. 

You can easily sort and locate data using table sorting and filtering 
options. However, these are relatively lightweight when compared 
to using queries. 

Queries are sometimes known as Query By Example, or QBE. A 
query is like a report based on the data in a table. With a query you 
are required to specify which fields to see in the query, and which 
records to display. 

This is done by giving Access criteria to search for, much the same 
as what is done for a simple filter. For example, listing all of the 
records that have Sales in the Department field, or all of the 
records that occurred on 12/3/2016, are examples of queries. 

Once the criteria and output fields are nominated, Access will 
search through the data and produce a table of matching records. 

INFOCUS 
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UNDERSTANDING QUERIES 
 

 

 

 

 

   

A select query is like a filter that you place on 
your data so that you see only the information 
that is relevant to you. Select queries can be 
used, for example, to produce a list of customers 

from Tasmania, or all of the items that you've 
purchased in the last six months valued at $300 or 
more. Select queries are so named because they 
select records according to your query design. 

Select queries are created 
using the Create tab of the 
ribbon, and are run and 
modified as a Query object 
in the Navigation pane. 

Select queries are based on 
a Query Design. The upper 
part of the design is known 
as the Field List, while the 
lower portion is known as the 

Query Grid. 

The records displayed in the 
query are determined by the 
sample data that you enter 
into the Criteria row in the 
Query Grid – this is why the 
process is sometimes 
referred to as query by 
example. 

The easiest way to see the 
data is to switch to 
Datasheet view. In 
Datasheet view the data that 
matches the query criteria is 
displayed in a special 
dynaset table. A dynaset is 
a subset of the full table of 
data – however, it is still a 
live set of data and any 
changes made to data here 
will be reflected back in the 
full table later on. 

Field list 

Query grid 

Criteria row 
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CREATING A QUERY DESIGN 
 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

Queries are created from the Create tab on the 
ribbon. Like table structures, there is a design 
view where the layout, criteria, and the like, 
required for the query are specified, and a run 

view where the data is brought into the design 
layout structure from the relevant table. The first 
step in creating a query, therefore, is to create a 
query design structure. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this 
exercise you MUST open 
the file Creating 
Queries_1.accdb… 

 
Click on the Create tab, 
then click on Query 
Design in the Queries 
group to display a new 
query design and the 
Show Table dialog box 

 
Click on [Add] to add the 
Employees table fields to 
the design, then click on 
[Close] to close the dialog 
box 

 
In the field listing 
double-click on EmpNo, 
LastName, FirstName 
and Department to add 
these fields to the grid in 
this order 

 
Click on Save in the QAT 
to display the Save As 
dialog box 

 
Type qryEmployees in 
Query Name, then click 
on [OK] 

The name of the query will 
now appear in the 
Navigation pane under the 
Queries header… 

 
Close the query 
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For Your Reference… 

To create a query design: 

1. Click on the Create tab 

2. Click on Query Design in the Queries group 

3. Add the table and select the fields 

4. Save the query 

3 

Handy to Know… 

 The Show Table dialog box, displayed when 
creating a new query design, lists all of the 
tables and queries in the current database 
file. 

Double-click on the entries here to add them to the 
table below 
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WORKING WITH A QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Queries offer you the ability to see snapshots of 
your data – a particular view or representation of 
your data at a point in time. There are three main 
views within a query: the design view where you 

specify what data you wish to see in the snapshot; 
the datasheet view where the data based on the 
design is displayed; and SQL view which shows 
the programming behind the query. 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Creating 
Queries_2.accdb... 

 
Double-click on 
qryEmployees to see 
the query in Datasheet 
view, displaying the data 

 
On the Home tab, click 
on the top half of View 
in the Views group to 
toggle between Design 
and Datasheet views 

 
Click on the bottom half 
of View to display a 
menu of options 

 
Select SQL View to see 
the SQL code required 
behind the scenes to 
create the query 

 
Close the query 

 

1 

For Your Reference… 

To see different aspects of a query: 

1. Double-click on the query to see it in 
Datasheet view 

2. On the Home tab, click on the top half of 
View in the Views group to toggle between 
Design and Datasheet views 

3 

Handy to Know… 

 Until you seriously get into programming, you 
won't use the SQL View option for queries all 
that often. SQL is pronounced "sequel" or 
simply S.Q.L. 

4 
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CHANGING A QUERY DESIGN 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Most query designs are not as critical as table 
designs and can therefore be changed randomly 
and when the need arises. Select queries, 
where you are trying to extract matching data, 

are often run using a trial and error approach where 
the query design is experimented with and modified 
until the perfect solution is found.  

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file Creating 
Queries_3.accdb... 

 
In the Navigation pane, 
right-click on 
qryEmployees to display a 
menu of options, then select 
Design View to see the 
query in Design view 

 
Scroll down the list of fields 
in the Employee field listing 
and double-click on 
WeeklyHours and then 
Salary to place both fields 
at the end of the grid 

 
Click on WeeklyHours in 
the grid then, on the Query 
Tools: Design tab, click on 
Insert Columns in the 
Query Setup group 

A new, blank column will 
appear… 

 
Click on the drop arrow in 
the new column and select 
Started 

 
Click on the Home tab, then 
click on the top half of View 
in the Views group to run 
the query and see the data 
presented in the modified 
design 

 
Click on Save in the QAT, 
then close the query 

 

2 

4 

For Your Reference… 

To insert more fields into a Design grid: 

 Double-click on the field name in the field 
listing, or 

 Click in the grid, then click on Insert 

Columns in the Query Setup group 

Handy to Know… 

 You can delete a field from a query grid by 
clicking on it and then clicking on Delete 
Columns in the Query Setup group on the 
Home tab. 

5 
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APPLYING RECORD CRITERIA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

The real power of a query lies in its ability to 
display a filtered list of records in a dynaset. To 
filter the records and see only the ones that you 
want, you will need to enter search criteria in the 

criteria row in the query grid. You simply type an 
example of the data that you want to see in the 
criteria cell and run the query to display all records 
from the original table that match the criteria. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or 
open the file Creating 
Queries_4.accdb... 

 
Right-click on 
qryEmployees to display a 
menu of options and select 
Design View 

 
Click in the Criteria cell for 
Department and type 
Administration 

 
On the Query Tools: 
Design tab, click on the top 
half of View in the Views 
group to see only those 
records with 
Administration in the 
Department field 

 
Repeat step 3 to switch 
back to Design view 

 
Type 40 in the Criteria cell 
for WeeklyHours, then click 
on View to display only 
those people who work 40 
hours in the 
Administration department 

 
Switch to Design view and 
type >=80000 in the 
Criteria cell for Salary, then 
click on View to see all 
Administration people who 
work 40 hours and earn 
$80,000 or more 

 
Save and close the query 

2 

3 

For Your Reference… 

To select records in a query: 

1. Click in the Criteria cell for a field and type 
the desired search criteria 

2. On the Query Tools:Design tab, click on 
View in the Views group to run the query 

Handy to Know… 

 When creating queries, if you add more 
criteria across fields, you are creating what is 
known as an AND query – you want records 
that have this AND this AND this... 

 When constructing queries, use > for greater 

than and < for less than situations. 

6 
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CLEARING SELECTION CRITERIA 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You do need to exercise a little care when 
running queries. If you leave residual criteria from 
an earlier query in the query grid (which is easy 
to do if you have more fields than can be seen on 

the screen), you may end up with incorrect results. 
It is a good idea therefore to clear the selection 
criteria after you have performed a query and found 
the data that you want. 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Creating 
Queries_5.accdb... 

 
In the Navigation pane, 
right-click on 
qryEmployees to display a 
menu of options and select 
Design View 

 
Point to the left of the first 
criteria cell until the mouse 
pointer changes to a black 
horizontal arrow  

 
Click once to select the 
entire criteria row 

 
Press  to delete all of 
the criteria in the row 

 
Save and close the query 

 

2 

For Your Reference… 

To clear selection criteria: 

1. Point to the left of the row and click once to 
select it 

2. Press  to delete the criteria in the row 

3 

Handy to Know… 

 When working with a query design, you can 
delete the contents of a single cell in the 
Criteria row by double-clicking on the value 

in the cell and pressing . 

4 
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SAVING A QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are two main types of select queries: those 
that you create as a one-off search of the data; 
and those that you create for repeated and 
on-going use. If you are going to use a query on 

a regular basis it should be saved. You can then 
also use it as a template to create other queries 
with variations perhaps to the criteria or the field 
grid. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file Creating 
Queries_6.accdb... 

 
Right-click on qryEmployees 
to display a menu of options 
and select Design View 

 
Type Administration in the 
Criteria cell for Department 

 
On the Query Tools: Design 
tab, click on View in the Views 
group to see the results – 
there should be 26 records 

 
Click on the File tab, then click 
on Save As to display the 
Save As area 

 
Click on Save Object As in 
File Types, then click on 
[Save As] to display the Save 
As dialog box 

 
Type qryEmployeesAdmin 
and click on [OK] 

The new query appears in the 
Navigation bar… 

 
Switch to Design view then 
repeat steps 2 to 6 to create 
another query that only 
displays employees from the 
Executive department – save 
this query as 
qryEmployeesExec 

 
Close the query 

 

3 

5 

7 

For Your Reference… 

To save a query: 

1. Create the query 

2. On the File tab, click on Save As, then click 
on Save Object As and click on [Save As] 

3. Type a name and click on [OK] 

Handy to Know… 

 It is important to give your queries 
meaningful names so that you remember 
what they are for. Using a prefix, such as 
qry, will tell you at a glance that you are 
looking at a list of queries and make the 
queries easier to distinguish from tables, 
forms and reports. 
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RUNNING QUERIES FROM THE NAVIGATION PANE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                   , 

Queries store the layout, fields, criteria and other 
information required to produce the list of data 
that you want. Given that they can be time 
consuming to create, especially in the case of 

complex queries, it makes sense to save them and 
then run them as often as you require. Queries can 
be run directly from the object listing in the 
Navigation pane, as often as you like. 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Creating 
Queries_7.accdb... 

 
In the Navigation pane 
under Queries, 
double-click on 
qryEmployees, then 
double-click on 
qryEmployeesAdmin, 
then double-click on 
qryEmployeesExec 

Notice how the names of 
the three queries appear 
in three separate tabs at 
the top of the window. 
The last query opened is 
the one that is currently 
seen and is known as the 
“active” query… 

 
Click on the tab for 
qryEmployeesAdmin to 
see the employees in the 
Administration 
department 

 
Click on the tab for 
qryEmployees to see all 
of the employees 

 
Close each query 

 

1 

2 

For Your Reference… 

To run a query from the Navigation pane: 

 In the Navigation pane, double-click on the 

name of the query from the Query object list 

Handy to Know… 

 Queries do not contain data. Each time a 
query is opened in Datasheet view, Access 
retrieves the latest data from the table upon 
which the query is based and uses the query 
design to display the relevant records and 
information. 

3 
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DELETING A QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Queries often work with data that is stored in 
tables or that results from other queries. They 
can be used to create data by performing 
calculations and can be used as a source of data 

for other queries, forms and reports. Therefore, you 
should be especially careful when deleting queries 
– make sure that the query is not used by any other 
objects in the database first. 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the 
file Creating 
Queries_7.accdb... 

 
Click on 
qryEmployeesExec in 
the Navigation pane 
to select it 

 
On the Home tab, click 
on Delete in the 
Records group 

A warning message 
will appear, seeking 
your confirmation to 
delete the query… 

 
Click on [Yes] to 
confirm the deletion 

The query no longer 
appears listed under 
Queries in the 
Navigation pane 

 

1 

2 

3 

For Your Reference… 

To delete a query from a database file: 

1. Click on the name of the query in the 
Navigation pane 

2. On the Home tab, click on Delete in the 
Records group 

Handy to Know… 

 You can delete a query by clicking on it in the 

Navigation pane and pressing . 
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CREATING ADDITIONAL QUERIES 
 

 

 

 

  

 

Select queries are by far the most common type 
of query that you will create and use. In this 
assignment you will have the opportunity to put 
your understanding of queries to use by creating 

a wide range of different queries, including those 
that show records that match specific criteria, and 
those that fit within specific ranges of dates. 
 

Sub Heading 

Use the qryEmployees query to run the various queries as shown. Note that you will have to clear the 
criteria from time to time. Also, we won’t need these queries so there is no need to save them. 

Save the final query design as qryEmployeesNew then close it. 

The datasheet that shows the results is exactly like a table and you can therefore use the Print 
commands on the File tab to print the result once the datasheet is displayed. 

Access automatically places quotation marks around criteria based on text. The quotation marks are 
programming symbols that tell the computer to treat the data as character strings rather than numbers. 
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NOTES: 
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CHAPTER 2 MULTI-TABLE QUERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 gain an understanding of how relational queries work 

 learn how to create a relational query design 

 learn how to filter a relational query 

 learn how to filter related fields and some of the 
associated problems 

 learn how to add more tables and fields to a query design 

 learn how to work with hidden fields in the query grid 

 gain an understanding of the three join types in Access 

 learn how to create an inner join query 

 learn how to create a left outer join 

 learn how to create a right outer join. 

The real benefits associated with relational databases and queries 
become clear when you need to create a query that draws on data 
from several tables. 

With single tables you can create filters that essentially filter out 
unwanted data and display only what you need to see. 

To draw data from several tables, however, you are better advised 
to create a query. Queries that span multiple tables actually use the 
underlying table join settings to extract data quickly and easily for 
either one-off informational queries or full scale report-destined 
queries. 

INFOCUS 
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UNDERSTANDING RELATIONAL QUERIES 
 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

  

A query is like a filter that you can place on your 
data so that you can see or work with only the 
information that is relevant. Queries are used to 
display data (Select query) or to change data 

(Update query). Relational queries involve one or 
more linked tables and are the ideal way to create 
reports comprising of data from several different 
tables. 

How Relational Queries Work 

All queries, including relational queries, are based on a Query Design. 

The upper part of the design is known as the Field List, where Access displays the table or tables 
used for the query. If more than one table is chosen and the chosen tables are related, relational links 
will show how the tables are connected. 

The lower part of the query design is known as the Query Grid, where Access displays the fields from 
the tables that need to be used in the query operation. You can choose all fields to display, or a subset 
of the fields, which is more common. The Query Grid is also used to enter examples of the data for 
the query to search for. This sample data is known as criteria. 

The Field List displays 
the related tables – 
note how the links 
provide information 
about the type of join. 

The Query Grid 
contains the settings 
that determine the data 
that will be presented. 

In the example above, fields from all of the tables have been pulled into the query grid. Because of the 
nature of the joins (one-to-many) the resultant query will use the data from the transaction table 
(Expense Transactions) and supplement it with information from the two lookup tables (Employees 
and Expense Type). 

The criteria above is asking Access to present us with all transactions on or after March 1, 2015, and 
for either meals or postage greater than or equal to $50. When run, the resultant query would appear 
as: 
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CREATING A RELATIONAL QUERY DESIGN 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
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Before starting this 
exercise you MUST 
open the file Multi Table 
Queries_1.accdb… 

 
Click on the Create tab, 
then click on Query 
Design in the Queries 
group to display the 
Show Table dialog box 

 
Double-click on the 
tables: Employees, 
Expense Transactions 
and Expense Type, then 
click on [Close] 

 
Double-click on the 
fields, as listed, to 
populate the query grid 

 
Click on Save in the 
QAT to display the Save 
As dialog box 

 
Type Employee 
Expenses in Query 
Name, then click on 
[OK] 

The new query is listed 
in the Navigation pane… 

 
On the Query Tools: 
Design tab, click on Run 
to run the query 

 
Close the query 

 

 

Irrespective of whether you are creating a query 
for a single table or for multiple tables, the query 
is originally created from options on the Create 
tab on the ribbon. The key to multiple-table 

queries is selecting the tables to use when the 
Show Table dialog box appears. Here you can 
select which tables to pull into the Field List on the 
query design. 

1 

For Your Reference… 

To create a relational query: 

1. Click on the Create tab and click on Query 
Design in the Queries group 

2. Double-click on the tables to add 

3. Double-click on the fields to add to the query 
grid 

2 

Handy to Know… 

 It doesn’t matter in which order you place 
tables in the Field List in the query because 
how the data is presented when the query is 
run is determined by the relationship joins. 

3 Table: Field: 

Expense Transactions ExpDate 

Expense Type 

Amount 

Employee FirstName 

LastName 

Department 

PhoneNo 
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FILTERING A RELATIONAL QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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Continue using the previous 
file with this exercise, or 
open the file Multi Table 
Queries_2.accdb... 

 
Open the query Employee 
Expenses in Design View 

 
Click in the Criteria cell for 
Amount and type >150 

 
On the Query Tools: 
Design tab, click on Run in 
the Results group to display 
all of the transactions greater 
than 150 

 
On the Home tab, click on 
the top half of View in the 
Views group to return to 
Design View, then delete 
the previous criteria and try 
each of the examples as 
shown (delete the previous 
criteria after each one) 

 
Close the query – click on 
[No] to close without saving 
the design changes 

 

A relational query is filtered in the same way as a 
single table query by providing examples of the 
data in the criteria cells displayed in the query 
grid. Text field examples need to be enclosed in 

quotation marks, but Access will do this for you. 
Numeric and date fields can make use of operators 
such as greater than, less than, equal to, and so 
on. 

2 

For Your Reference… 

To filter a relational query: 

1. Open the query in Design View 

2. Type a relevant example or expression in the 

Criteria cell of the appropriate fields 

3 

Handy to Know… 

 If you save a query as it is closed, the last 
criteria example used will be saved with the 
query. If you want to keep the Criteria cells 
clear, don’t save the query. 

Field: Criteria: 

Department Executive 

ExpDate >01/07/08 

ExpDate Between 01/06/08 And 30/06/08 

 

4 
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FILTERING RELATED FIELDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The real strength of related queries is not only 
being able to choose fields from different tables 
for the query, but also to be able to filter them 
and provide them with criteria values. While this 

works well for most fields, there are a few problems 
when trying to filter on the lookup fields that have 
been used to create the relationship between the 
tables. 

Try This Yourself: 

S
a

m
e
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Continue using the previous 
file with this exercise, or open 
the file Multi Table 
Queries_2.accdb... 

 
Open the query Employee 
Expenses in Design View 

 
Click in the Criteria cell for 
Expense Type and type 
Meals 

 
On the Query Tools: Design 
tab, click on Run in the 
Results group 

An error message will appear 
indicating a data mismatch. 
This has occurred because 
Expense Type is actually a 
numeric field which looks up 
the Expense Type table using 
the ExpTypeNo field… 

 
Click on [OK] to close the 
message 

 
Select the value in Criteria for 
Expense Type and type 6 

This is the ExpTypeNo for 
Meals… 

 
On the Query Tools: Design 
tab, click on Run in the 
Results group to display all of 
the transactions for Meals 

 
Close the query – click on [No] 
to discard the changes 

 

2 

3 

For Your Reference… 

To filter related fields: 

1. Type examples into the Criteria cell of any 
field in the query grid 

2. Take care to compensate for lookup fields 

6 

Handy to Know… 

 Using incorrect syntax when entering criteria 
can generate a data type mismatch error. For 
instance, if you place numerical or date 
criteria in quotation marks, rather than cross 
hatch symbols (#), Access interprets the data 
as text, rather than numbers. 
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ADDING MORE TABLES AND FIELDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Query designs do not need to be static in design 
– you can add (or remove) tables and fields as 
dictated by your reporting needs. In our case 
study we have a Personal Details table that can 

be added to the design to provide us with extra 
fields for our employees, such as Salary. 

Try This Yourself: 

S
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Continue using the previous 
file with this exercise, or 
open the file Multi Table 
Queries_2.accdb... 

 
Open the query Employee 
Expenses in Design View 

 
On the Query Tools: Design 
tab, click on Show Table in 
the Query Setup group to 
display the Show Table 
dialog box 

 
Double-click on Personal 
Details to add it to the 
design, then click on [Close] 

 
Double-click on Salary to 
add the field to the grid 

 
Click on Save in the QAT to 
save the changes 

 
Click in the Criteria cell for 
Salary and type >=85000 

 
On the Query Tools: Design 
tab, click on Run in the 
Results group, to display 
expense transactions for 
employees with a salary 
greater than or equal to 
85,000 

 
Close the query – click on 
[No] to discard the criteria 
changes 

 

3 

6 

For Your Reference… 

To add more tables to a query design: 

1. Open the query in Design View 

2. On the Query Tools: Design tab, click on 
Show Table in the Query Setup group 

3. Double-click on the table(s) to add 

4. Click on [Close] 

7 

Handy to Know… 

 Save a query design after making a 
structural change to the design, and before 
you add criteria, to then be able to close the 
table later without the criteria but with the 
structural alteration. 
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UTILISING HIDDEN FIELDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Earlier we encountered a problem when we tried 
to enter text into a field that was numeric even 
though, because of its lookup arrangement, it 
displayed text results. The problem with our 

solution was that we have to enter the criteria as a 
numeric code. Utilising a hidden field, we can 
enter text values and have the correct result 
displayed without incurring a data mismatch error. 

Try This Yourself: 

S
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m
e
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Continue using the previous 
file with this exercise, or 
open the file Multi Table 
Queries_3.accdb... 

 
Open the query Employee 
Expenses in Design View 

 
In the query grid, click on 
the Show box for Expense 
Type so it appears without a 
tick – this will hide the field 
when the query is run 

 
In the Field List, double-
click on Description in the 
Expense Type table to add 
it to the end of the query grid 

 
Click on Save in the QAT to 
save these changes 

 
Click in the Criteria cell for 
Description and type Meals 

 
On the Query Tools: 
Design tab, click on Run in 
the Results group to display 
all of the Meals transactions 

 
Close the query – click on 
[No] to discard the changes 
since the last save 

 

2 

5 

For Your Reference… 

To hide a field from a query when it is run: 

 In the query grid, click on the Show box for 
the field so it appears without a tick 

Handy to Know… 

 Hiding a field from the query grid is better 
than removing it, as it still enables you to 
search the records based on that field. 

6 
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UNDERSTANDING QUERY JOINS 
 

 

 

 

 

 

In addition to selecting specific fields and 
specifying criteria for a query, the data that is 
displayed in a multi-table query is also influenced 
by the type of join that has been specified 

between the tables. Basically there are three types 
of joins at your disposal: an inner join, a left outer 
join and a right outer join. In Access these joins 
are numbered 1 to 3 respectively. 

A Classic Join Example 

The easiest way to understand the different joins is through the use of a simple example. Let’s 
assume you have two tables, one for Employees and the other for their expense transactions. The 
Employee table would have one record per employee, while the Expense Transactions table could 
have many transactions per employee. 

Join 1: An Inner Join 

This is the default join type in Microsoft Access 
and is the one most commonly used. In this type 
of join the query will display only employees who 
have transactions and the transactions recorded 
against them. Employees who do not have any 
transactions will not be shown, nor will 
transactions that are orphaned and do not have 
an associated employee (there really shouldn’t 
be any of these). 

Join 2: An Outer Left Join 

Let’s suppose you want to see all employees, 
irrespective of whether they do or don’t have 
transactions, as well as their transactions. An 
Outer Left Join achieves this. Again, orphaned 
transactions that do not have any associated 
employee will not appear. 

Join 3: An Outer Right Join 

Let’s suppose you want to see all of the 
transactions, both those that have associated 
employees and those that are orphaned, then 
use the Outer Right Join. This join focuses on 
the transaction side of the join showing all 
transactions, but only employees from the left 
side that have transactions. 

Join Properties 

When you right-click on a join between tables 
you can open the Join Properties dialog box. In 
this dialog box you can specify the type of join to 
work with. 
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CREATING AN INNER JOIN 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
p
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n

 

F
il

e
 Before starting this exercise you 

MUST open the file Multi Table 
Queries_4.accdb… 

 
Click on the Create tab, then 
click on Query Design in 
Queries 

 
Double-click on Employees and 
then on Expense Transactions, 
then click on [Close] 

 
Right-click on the line that joins 
both tables and select Join 
Properties to display the Join 
Properties dialog box 

 
Ensure option 1: is selected, 
then click on [OK] 

 
Double-click on the EmpNo, 
FirstName and LastName fields 
in the Employees table, and the 
asterisk (*) in the Expense 
Transactions table 

 
On the Query Tools: Design 
tab, click on Run in the Results 
group to run the query and note 
the records 

 
Click on the File tab, select 
Save As, then click on Save 
Object As and click on [Save 
As] 

 
Type qryInnerJoin, then click 
on [OK] 

 
Close the query 

Inner Joins are the default join type and are 
automatically created for you when you have two 
joined tables in a query. Essentially an inner join 
shows only records from either table that are 

matched in the other table. Records in the left table 
that do not have matches in the right table won’t 
appear, nor will records in the right table that aren’t 
matched to records in the left table. 

2 

3 

For Your Reference… 

To create an inner join query: 

1. In query Design View, right-click on the join 
line, then select Join Properties 

2. Ensure option 1: is selected and click on 

[OK] 

Handy to Know… 

 With an inner join query, which is the default 
join type, only records from the left table that 
have matches in the right table are joined. 
Orphans from the right table are not shown 
when the query is run. 

6 
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CREATING A LEFT OUTER JOIN 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

With left outer joins the table on the left side of 
the join has precedence and all records of that 
table, irrespective of whether they have matching 
records in the right table, will appear. Records 

from the right table will only appear if they are 
matched to records in the left. With a left outer join 
it is the left table that is ‘dominant’. 

Try This Yourself: 

S
a

m
e
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Continue using the previous 
file with this exercise, or open 
the file Multi Table 
Queries_5.accdb... 

 
Open the query qryInnerJoin 
in Design View 

 
Click on the File tab, select 
Save As, click on Save 
Object As, then click on 
[Save As] 

 
Type qryLeftOuterJoin, then 
click on [OK] 

 
Right-click on the join line and 
select Join Properties 

 
Click on option 2:, then click 
on [OK] 

 
On the Query Design: Tools 
tab, click on Run in the 
Results group to run the 
query 

This time all employees, 
whether they have 
transactions or not, will be 
displayed… 

 
Save and close the query 

 

4 

5 

For Your Reference… 

To create a left outer join query: 

1. In query Design View, right-click on the join 
line, then select Join Properties 

2. Click on option 2: and click on [OK] 

Handy to Know… 

 Follow the arrow in a join between tables in a 
query to get an idea of what is happening. If 
an arrow points to the right table, then all of 
the records from the left will appear but only 
matching ones from the right will show up. 

6 
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CREATING A RIGHT OUTER JOIN 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file Multi Table 
Queries_6.accdb... 

 
Open the query qryInnerJoin 
in Design View 

 
Click on the File tab, select 
Save As, click on Save 
Object As, then click on 
[Save As] 

 
Type qryRightOuterJoin, 
then click on [OK] 

 
Right-click on the join line, 
then select Join Properties 

 
Click on option 3:, then click 
on [OK] 

 
On the Query Tools: Design 
tab, click on Run in the 
Results group to run the 
query 

This time all transactions, 
whether they have associated 
employees or not, will be 
displayed… 

 
Save and close the query 

 

In a right outer join the table on the right, which 
is usually the transaction table, is the dominant 
table. In this type of join, all of the transactional 
records will appear irrespective of whether they 

are orphaned (don’t have a match on the left) or 
not. In a good database design there should never 
be unmatched transactions – so this type of query 
is ideal for tracking down data problems. 

4 

5 

For Your Reference… 

To create a right outer join: 

1. In query Design View, right-click on the join 
line, then select Join Properties 

2. Click on option 3: and click on [OK] 

Handy to Know… 

 Databases with sound rules of referential 
integrity should never present unmatched 
transactions. For example, in a good system 
you should not be able to delete an 
employee if there are still open transactions 
for that employee. 

6 
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NOTES: 
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CHAPTER 3 PARAMETER QUERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 learn how to create a parameter query 

 learn how to display all records using a parameter query 

 learn how to use parameters to display a range of values 

 learn how to use parameters in expressions 

 learn how to use wildcards with parameter queries. 

A query selects data based on a field list and criteria that are 
entered into the query grid. This is fine if the criteria and field list 
never change. However, you may find that you need to run a query 
on a regular basis with different criteria depending on particular 
situations or events. 

A parameter query can save you the hassle of entering Design 
View and manually changing the criteria of a saved query. A 
parameter in computer language refers to some information or data 
that is passed from one object to another. In a parameter query, the 
parameter is simply the example that needs to be entered into the 
criteria cell of the query grid. 

When you run a parameter query, you are prompted for the criteria 
by a user-friendly dialog box. The criteria you type are placed 
temporarily in the query grid to create the query.  

INFOCUS 
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CREATING A PARAMETER QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
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Before starting this exercise 
you MUST open the file 
Parameter 
Queries_1.accdb... 

 
Open 
qryEmployeeExpenses in 
Design View 

 
Click in the Criteria cell for 
Description and type 
[Enter the description of 
the transactions] 

The square brackets tell 
Access that this is a 
parameter query and the 
text serves as the prompt… 

 
On the Query Tools: 
Design tab, click on the top 
half of View in the Results 
group to run the query 

You will be prompted for a 
description… 

 
Type Postage, then click on 
[OK] to see all of the 
postage transactions (52 
records) 

 
Click on the File tab, click 
on Save As, then click on 
Save Object As and click 
on [Save As] 

 
Type Query – Parameter 
Query Example in Save to, 
then click on [OK] 

 
Close the query 

A parameter query is created in the same way 
as a normal query, except that you place square 
brackets around text in a criteria cell in lieu of an 
example of the search data. Access uses this text 

as a prompt in a dialog box that appears when the 
query is run. Whatever the user types as a 
response to this prompt then becomes the criteria 
(passed as a parameter) in the query. 

2 

3 

For Your Reference… 

To create a parameter query: 

1. Create the query in Design View 

2. In the Criteria cell, type a prompt enclosed 
in square brackets that will be used for the 
query 

4 

Handy to Know… 

 When creating queries, you can enter 
parameters for more than one field. Access 
will stop the query for each one and prompt 
for criteria. Too many stops and prompts can 
become very frustrating. As an alternative 
you could create a form to capture the data 
required for the query. 



Microsoft Access 2016 - Advanced Queries 

© 2017 The University of Nottingham Page 27 Chapter 3 - Parameter Queries 

DISPLAYING ALL RECORDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

When you leave a parameter prompt box empty 
you would expect that all of the records are 
displayed, however they’re not. Instead, you get 
nothing. If you want the option to see all of the 

records when you leave the prompt box empty, you 
can use an OR expression to display a repeat of 
the prompt and test to see if it hasn't been used – 

in other words, if it is Null. 

Try This Yourself: 

S
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Continue using the previous 
file with this exercise, or 
open the file Parameter 
Queries_2.accdb... 

 
Double-click on Query – 
Parameter Query Example 
to display the Enter 
Parameter Value dialog box 

 
Leave the dialog box empty 
and click on [OK] 

Nothing appears to have 
happened… 

 
On the Home tab, click on 
the top half of View in the 
Views group, then click in 
the or cell for Description 
and type [Enter the 
description of the 
transactions] Is Null 

 
Click on the top half of View 
to display the dialog box 
again 

 
Leave the dialog box empty 
and click on [OK] 

All records are displayed… 

 
Click on the File tab, click on 
Save As, then click on Save 
Object As and click on 
[Save As] 

 
Type Query – Displays All 
Example in Save to, then 
click on [OK] 

 
Close the query 

1 

2 

5 

For Your Reference… 

To display all records in a parameter query: 

1. In query Design View, click in the or cell and 
re-type the parameter prompt 

2. Add the text Is Null to the end of the second 
parameter prompt 

Handy to Know… 

 Is Null is not an easy concept to understand 
– basically it translates as “is nothing there”. 
By duplicating parameter text and adding Is 
Null to the second parameter, the query is 
run with valid criteria or if there is nothing in 
the criteria, then it ignores the parameter 
request and shows everything. 

3 
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USING PARAMETERS TO DISPLAY A RANGE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file Parameter 
Queries_3.accdb... 

 
Open qryEmployeeExpenses 
in Design View 

 
Click in the Criteria cell for 
ExpDate and type Between 
[Enter Start Date] AND 
[Enter End Date] 

 
On the Query Tools: Design 
tab, click on the top half of 
View in the Results group to 
display the first prompt box 

 
Type 1/3/15, then click on 
[OK] to display the second 
prompt box 

 
Type 31/3/15 and click on 
[OK] to display all of the 
transactions for March 

 
Click on the File tab, click on 
Save As, then click on Save 
Object As and click on [Save 
As] 

 
Type Query – Parameter 
Range Example in Save to, 
then click on [OK] 

 
Close the query 

 

There is no rule in Access to say that you can 
only use one parameter in a query. Two 
parameters are quite acceptable when working 
with criteria that are based on a range. A typical 

use for parameters is to capture dates where you 
want to specify a start date and an end date. The 
parameters will cause the query to extract all of the 
records between these two dates. 

2 

3 4 

For Your Reference… 

To create parameters for a range: 

1. In query Design View, click in the Criteria 
cell and type Between 

2. Type the first parameter 

3. Type AND 

4. Type the second parameter 

Handy to Know… 

 When constructing queries to display a 
range, the Between…And operators can 
also be used without parameters. For 
example, you can type Between 1/3/13 And 
31/3/13 to create a hard-coded select query. 

5 
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USING PARAMETERS IN EXPRESSIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Expressions (formulas) are quite often used in 
field cells to create calculated fields in a query. 
Access allows you to place a parameter within an 
expression in lieu of a value or field. All that you 

need to do is create a prompt, enclose it within 
square brackets, and place it in the expression at 
the place where you want the value to appear. The 
value is entered when the query runs. 

Try This Yourself: 
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Continue using the previous 
file with this exercise, or open 
the file Parameter 
Queries_4.accdb... 

 
Open 
qryEmployeeExpenses in 
Design View 

 
Click on the grey bar above 
LastName to select the 
column, then on the Query 
Tools: Design tab click on 
Insert Columns in the Query 
Setup group to insert a new 
field 

 
Click in the Field cell for the 
new column and type 
Amount+[Enter a handling 
fee] 

 
Click on the top half of View 
in the Results group to trigger 
the handling fee prompt 

 
Type 2.50, then click on [OK] 
to display the transactions 
with an extra $2.50 added to 
each 

 
Click on the File tab, click on 
Save As, then click on Save 
Object As and click on [Save 
As] 

 
Type Query – Parameter 
Expression Example in 
Save to, then click on [OK] 

 
Close the query 

 

2 

3 

4 

For Your Reference… 

To create an expression with a parameter: 

1. In query Design View, click in a free Field 
cell 

2. Type the expression but include a parameter 
prompt where you would normally type a 
value or field name 

Handy to Know… 

 When creating queries, expressions that 
contain parameters are ideal for "what-if" 
analyses where you run the query with 
different values. 

5 
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USING PARAMETERS WITH WILDCARDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Parameter queries are ideal for allowing the 
user to specify the selection criteria without the 
need for hard-coding samples. Wildcards are 
great for using a scatter-gun approach to 

searching for records. The two can be combined 
using string concatenation techniques where the 
parameter statement is joined to the wildcard using 
an ampersand character (&). 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Parameter 
Queries_5.accdb... 

 
Open 
qryEmployeeExpenses in 
Design View 

 
Click in the Criteria cell for 
LastName and type Like 
[Enter Lastname starting 
letter] & “*” 

 
Click on the File tab, click 
on Save As, then click on 
Save Object As and click 
on [Save As] 

 
Type Query – Parameters 
with Wildcards in Save to 
and click on [OK] 

 
On the Query Tools: 
Design tab, click on the top 
half of View in the Results 
group 

You should now be 
prompted for a starting 
letter… 

 
Type M, then click on [OK] 
to see all records where the 
last name begins with the 
letter M 

 
Close the query 

 

2 

5 

For Your Reference… 

To use a wildcard in a parameter query: 

1. In query Design View, type the parameter 
criteria 

2. Type an ampersand (&) after the criteria 

3. Type the wildcard character or expression 
enclosed in quotation marks 

Handy to Know… 

 When constructing parameter queries, if the 
wildcard is at the start of the expression, you 
can actually use more than one letter to 
further refine the search. For example, typing 
MO in a prompt box asking for the letter that 
a last name begins with, will display only last 
names that begin with MO. 

6 
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CHAPTER 4 CALCULATIONS IN QUERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 learn how to create a calculated field 

 learn how to rename expressions and format calculated 
fields 

 learn how to summarise data in a query 

 learn how to change the grouping in a summary query 

 learn how to perform calculations in queries using dates 

 learn how to use criteria in calculated fields 

 learn how to concatenate fields together. 

Queries can be used to combine data from different tables to create 
detailed lists. Data columns can be also added to a query by typing 
formulas in the field cells of a query grid. These formulas are known 
as expressions, and the new fields are known as calculated 
fields. Expressions can include arithmetic signs, numbers, field 
names, and special built-in functions. 

The typical use for calculated fields is to add or multiply the values 
in existing fields to produce a new value. For example, in an invoice 
table you may have a field for quantity and a field for price. Using 
a calculated query you can multiply the two together to create a 
calculated field showing the total.  

INFOCUS 
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CREATING A CALCULATED FIELD 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A calculated field is created by typing an 
expression (or formula) into a new field column in 
a query grid. The expression normally contains a 
reference to one or more existing fields in the 

query and these are shown enclosed in square 
brackets. Calculations conform to the standard 
mathematical rules of BODMAS. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise you 

MUST open the file Calculation 
Queries_1.accdb… 

 
Open qryExpenses in Design 
View 

Let’s calculate the value of tax, 
where tax is 10% of the total… 

 
Click in the blank Field cell to 
the right of Amount and type 
[Amount]/1.1 

This will create a new field… 

 
Click in the next blank Field cell 
and type [Amount]-

([Amount]/1.1) then press  

By default, Access names the 
new fields Expr1 and Expr2… 

 
On the Query Tools: Design 
tab, click on the top half of View 
in the Results group to run the 
query and see the calculations  

If hash signs appear, 
double-click on the field heading 
borders to perform a best fit… 

 
Click on the File tab, click on 
Save As, then click on Save 
Object As and click on [Save 
As] 

 
Type Query – Calculated 
Fields Example in Save to, 
then click on [OK] 

 
Close the query 

 

2 

3 

For Your Reference… 

To create a calculated field in a query grid: 

1. In query Design View, click in the first blank 
column 

2. Type a calculation expression (reference 
existing fields by enclosing the field name in 
square brackets) 

3. Run the query 

4 

Handy to Know… 

 Access will assign a default field name to a 
calculation in a query. It appears as Expr 
(which is an abbreviation for Expression) 
followed by a sequential number. 
Calculations often appear unformatted. 
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FORMATTING CALCULATED FIELDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

A calculated field appears with a default column 
heading. Obviously, it would be more 
aesthetically pleasing to nominate a more 
descriptive heading for the column. In addition, 

the data is displayed without any formatting. This 
can be changed using the Field Properties of the 
column which allow you to change the format so 
that the values will appear with currency symbols. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous file 
with this exercise, or open the 
file Calculation 
Queries_2.accdb... 

 
Open Query – Calculated 
Fields Example in Design 
View 

 
In the query grid select the text 
Expr1, then type NetAmount 

 
On the Query Tools: Design 
tab, click on Property Sheet in 
the Show/Hide group to display 
the Property Sheet pane 

 
Click in the cell for Format, 
then click on the drop arrow 
and select Currency 

 
In the query grid select the text 
Expr2, then type Tax 

 
Repeat step 4 to apply the 
Currency format 

 
Click on the top half of View in 
the Results group to run the 
query 

 
Click on the File tab, click on  
Save As, then click on Save 
Object As and click on [Save 
As] 

 
Type Query – Formatted 
Fields Example in Save to and 
click on [OK], then close the 
query 

 

2 

4 

5 

For Your Reference… 

To change the name of an expression: 

1. Double-click on the name to select it 

2. Type a new name for the expression 

To format an expression: 

 Use the Property Sheet pane settings to 
make appropriate changes 

Handy to Know… 

 When formatting calculated fields, the 
formatting options in the Property Sheet 
pane will change slightly depending upon the 
data type of the field. For example, Currency 
is only available for fields of a currency or 
numeric data type. 

7 
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SUMMARISING DATA USING A QUERY 
 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

Queries can also be used to summarise your 
data. This is done by adding a Total row to the 
query grid. When this is done you can use some 
of the special operators available for 

summarising data including: sum, avg, min, max, 
count, StDev, and var. There are also options to 
find the value of the first or last records. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file 
Calculation Queries_3.accdb… 

 
Double-click on 
qrySummedExpenses to run 
the query 

 
On the Home tab, click on the 
top half of View in the Views 
group to display the query in 
Design View 

 
On the Query Tools: Design 
tab, click on Totals in the 
Show/Hide group to add a 
Total row to the query grid 

 
Click on Group By for the 
Amount field, then click on the 
drop arrow and select Sum 

This will sum (total) this field… 

 
Repeat step 4 for the Net 
Amount and Tax fields 

 
Click on the top half of View in 
the Results group to see the 
totals grouped by Description 

 
Click on the File tab, click on 
Save As, then click on Save 
Object As and click on [Save 
As] 

 
Type Query – Summing Data 
Example and click on [OK] 

 
Close the query 

 

3 

5 

For Your Reference… 

To summarise data in a query: 

1. In query Design View, on the Query Tools: 
Design tab, click on Totals in the 
Show/Hide group 

2. Change Group By to Sum for the numeric 
fields 

6 

Handy to Know… 

 Using the Sum value in the Total field of a 
query works by totalling (summing) each 

category from the Group By field. 
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CHANGING THE GROUPING 
 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The key to understanding summary queries lies 
in the Group By field. In a summary query each 
example of the data in the Group By field is 
calculated and the result is displayed in the 

query. You can easily change the Group By field to 
calculate on other fields. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file Calculation 
Queries_4.accdb... 

 
Open Query – Summing Data 
Example in Design View 

Let’s change the query so that 
we see the daily totals for 
expenses rather than for each 
Description… 

 
In the query grid, click on the 
drop arrow for the Description 
field to see a list of fields from 
the Expense Transactions 
table, then click on ExpDate 

 
On the Query Tools: Design 
tab, click on the top half of 
View in the Results group to 
see the daily totals for 
expenses 

 
Click on the top half of View in 
the Views group to return to 
Design View 

 
Repeat steps 2 and 3 to see 
the expenses totalled by 
Employee 

 
Click on Save to save the 
changes to the query 

 
Close the query 

 

2 

3 

5 

For Your Reference… 

To change the grouping in a summary query: 

1. In query Design View, click on the field to 
change and click on the drop arrow 

2. Select the desired field 

3. Run the query 

Handy to Know… 

 You can have more than one Group By field 
in a summary query. If you do, Access will 
cascade them. For example, if you have 
Department as the Group By, and then 
LastName as a Group By, Access will group 
all of the records first by Department and 
then by LastName within each Department. 
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CALCULATING WITH DATES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Dates in computers are really just numbers. Each 
day of the year, the century, the millennium, has 
a unique number attached to it. Since these 
numbers run sequentially they can be used to 

perform date arithmetic. Using this principal we can 
perform a great variety of arithmetic on dates to 
calculate ages, seniority, and the like. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this exercise 
you MUST open the file 
Calculation 
Queries_5.accdb… 

 
Open qryEmployees in 
Design View 

 
Type the two calculated 
fields into blank columns, as 
shown 

 
Click on the first calculated 
date then, on the Query 
Tools: Design tab, click on 
Property Sheet in the 
Show/Hide group to display 
the Property Sheet pane 

 
Click in Format and type 
#,##0.0” Yrs” 

 
Repeat step 4 for the 
second calculated date, 
then close the Property 
Sheet pane 

 
Click on the top half of View 
in the Results group to see 
the calculations 

 
Click on the File tab, click 
on Save As, then click on 
Save Object As and click 
on [Save As] 

 
Type Query – Date 
Calculation Example in 
Save to, then click on [OK] 

 
Close the query 

 

Service: (Now()-[Started])/365.25 

Calculates the years of Service by calculating the number of 
days between the serial number for the date Started (must be in 
square brackets) and Now, then divides the result by the 
number of days in a year. 

Age: (Now()-[DateOfBirth])/365.25 

Calculates Age by calculating the number of days between the 
serial number for the DateOfBirth and Now, then divides the 
result by the number of days in a year. 

2 

4 

For Your Reference… 

To create calculated dates: 

1. In query Design View, click in the first free 
column 

2. Type a formula – a date field must be 
enclosed in square brackets 

3. Run the query 

6 

Handy to Know… 

 In queries, when calculating with dates, date 
fields from the table must be shown in 
square brackets ([ ]). You can also refer to a 
specific date by enclosing it between hash 
signs. For example, if you want to reference 
March 10, 2016 you would type it as 
#10/3/2016#. 
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USING CRITERIA IN CALCULATIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Calculation 
Queries_6.accdb... 

 
Open Query – Date 
Calculation Example in 
Design View 

 
Click in the Criteria cell for 
Age and type <=50 

 
On the Query Tools: 
Design tab, click on the top 
half of View in the Results 
group to see all employees 
who are 50 years or 
younger 

 
Click on the top half of 
View in the Views group to 
return to Design View 

 
Clear the Criteria in Age 
and try the other examples, 
as shown 

 
Click on the File tab, click 
on Save As, then click on 
Save Object As and click 
on [Save As] 

 
Type Query – Criteria in 
Calculations Example in 
Save to, then click on [OK] 

 
Close the query 

 

5 

For Your Reference… 

To apply criteria to a calculated field: 

1. In query Design View, click in the Criteria 
cell of the calculation field 

2. Type the criteria 

3. Run the query 

Once a calculated field has been created, it is 
much the same as any other field in the query 
grid. Just like the other fields it also has a 
Criteria cell and you can add selection criteria to 

it. For example, you can use the criteria field to find 
out how many employees have more than three 
years of service. 

2 

Note: your screen will vary from this one because the Age and 
Service calculations are based on the current date at the time that 
you run the query 

3 

Criteria Will show… 

>=50 Employees 50 years or over 

>=20 AND <30 Employees in their 20s 

>=20 OR <30 Trick one! Returns all 
employees – can you figure 
out why? 

(>=20 AND <30) OR (>=40 AND <50) Employees either in their 
20s or 40s 

 

Handy to Know… 

 In a query, if you have a numerical field and 
you apply the criteria >=20 OR <30 you will 
return all records because each record is 
either greater than (or equal to) 20 or less 
than 30. The two dates therefore negate one 
another. 
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CONCATENATING STRING FIELDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Calculation 
Queries_7.accdb... 

 
Open qryEmployees in 
Design View 

 
Click in the first blank 
Field cell and type the 
field as shown 

 
On the Query Tools: 
Design tab, click on the 
top half of View in the 
Results group to run the 
query 

Notice how the fields have 
been joined to the text in 
quotation marks, using an 
ampersand character… 

 
Click on the File tab, click 
on Save As, then click on 
Save Object As and click 
on [Save As] 

 
Type Query – 
Concatenation Example 
in Save to, then click on 
[OK] 

 
Close the query 

 

For Your Reference… 

To concatenate fields: 

1. In query Design View, click in the first 
available blank column 

2. Type an expression joining fields together 
using the ampersand character (&) 

3. Run the query 

Concatenation refers to joining things together. 
There may be times in an application when you 
want to have two fields concatenated. This can 
be done using an expression in a calculated 

query and combining the two fields together using a 
special character. The character used to join fields 

is the ampersand (&). 

Submitted by:[FirstName] & “ “ & [LastName] 

& “ from “ & [Department] 
2 

3 

Handy to Know… 

 When concatenating string fields in a query, 
you can use a plus sign (+) to join fields. 
However, this can be a little confusing as it 
normally denotes arithmetic additions. It is 
best, therefore, to use the ampersand (&) for 
concatenation. 
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CHAPTER 5 AGGREGATION QUERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 learn how to create an aggregation query 

 learn how to work with aggregation queries 

 learn how to create more than one aggregation in a query 

 learn how to modify aggregation headings 

 learn how to aggregate calculated fields 

 learn how to apply criteria to aggregations 

 gain an understanding of nesting queries 

 learn how to create an assembly query for nesting 

 learn how to create nesting queries. 

Aggregation queries are another form of calculation query where 
the values in one or more fields are aggregated to produce totals, 
averages, counts, and the like. 

In its simplest form an aggregation query allows you to sum the 
values in a column (field). Unlike a spreadsheet where you have to 
enter a formula or function to do this, Access takes care of all of the 
formula building for you – all you need to do is to specify the 
settings. 

INFOCUS 
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CREATING AN AGGREGATION QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
p

e
n

 

F
il

e
 

Before starting this exercise 
you MUST open the file 
Aggregate 
Queries_1.accdb… 

 
Click on the Create tab, then 
click on Query Design in the 
Queries group to display the 
Show Table dialog box 

 
Double-click on each of the 
tables to add them to the 
query, then click on [Close] 

 
Double-click on the fields as 
shown to place them in the 
grid 

 
On the Query Tools: Design 
tab, click on Totals in the 
Show/Hide group, to add the 
Totals row to the grid 

 
Click on Group By for 
Amount, click on the drop 
arrow, then select Sum 

 
On the Query Tools: Design 
tab, click on Run in the 
Results group to run the 
query 

 
Click on the File tab, select 
Save As, click on Save 
Object As, then click on 
[Save As] 

 
Type Expenses Summary, 
then click on [OK] 

 
Close the query 

 

An aggregation query begins as a select query. 
You start by choosing the tables or queries that 
the new query will be based on and the fields to 
include in the query. You then specify a 

calculation operation for at least one field in its 
Total row. There are a number of operations that 
can be used including Sum, Count, Average, Min, 
and Max. 

Table: Field: 

Employees Department 

Expense Type Description 

Expense Transactions Amount 

 

3 

5 

For Your Reference… 

To create an aggregation query: 

1. Create the query design 

2. On the Query Tools: Design tab, click on 
Totals in the Show/Hide group 

3. Change the Group By to an aggregation 
operation for the appropriate fields 

Handy to Know… 

 Group By is the real key to the operation in 
an aggregation query. If a SUM operation is 
performed for example, the Group By 
translates as “group by this field and sum 
each of the categories in the group”. 

6 
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WORKING WITH AGGREGATION QUERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you have only one Group By field in an 
aggregation query, the data will be grouped by 
each unique entry in the Group By field. If you 
have more than one Group By field, the records 

will be grouped in a nested configuration where the 
first field forms the first group, the second field is 
then grouped within the first group, the third field is 
grouped within the second group, and so on. 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Aggregate 
Queries_2.accdb... 

 
Open the query 
Expenses Summary in 
Design View 

 
Rework the query grids as 
shown – save after each 
one, using the names as 
shown 

 
Close the last query you 
worked on 

 

2 

Save as: Total By Employee 

Save as: Total By Type 

For Your Reference… 

To use Group By in aggregation queries: 

1. Double-click on database fields to add them 
to the query grid and ensure the Total row is 
visible 

2. Use Group By to determine the order and 
grouping of the records, or select a summary 
function if required 

Handy to Know… 

 When working with aggregation queries, 
don’t be tempted to have too many groups 
because the resulting report may be quite 
meaningless. It is better to have two or three 
simple reports than a highly detailed one that 
is difficult to interpret. 

Save as: Total By Date And Type 

Save as: Total By Date 
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MULTIPLE AGGREGATIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Aggregate 
Queries_3.accdb... 

 
Open the query Expenses 
Summary in Design View 

 
Double-click on Amount in 
the Expense 
Transactions table three 
times to add the field three 
more times to the grid 

 
Click on Group By for the 
second Amount field, click 
on the drop arrow, then 
select Count 

 
Repeat step 3 and change 
the third Amount field to 
Avg 

 
Repeat step 3 and change 
the fourth Amount field to 
Max 

 
Click on the File tab, select 
Save As, click on Save 
Object As, then click on 
[Save As] 

 
Type Expenses Statistics, 
then click on [OK] 

 
Run the query to see the 
data 

 
Close the query 

 

For Your Reference… 

To use multiple aggregations in a query: 

1. Display the Total row in the query grid 

2. Add the field(s) to aggregate 

3. Click on the drop arrow for Group By for 
each field and select an aggregate function 

Handy to Know… 

 When running multiple aggregates, empty 
rows (null values) will not be included in 
calculations. To convert null values to zero, 
use the Nz function. For example, the value 
of the calculated field Nz([Amount],0) will be 
the amount if the field Amount is not null, or 
zero if it is null. 

An aggregate query can use multiple fields for 
calculating operations. They are not limited to 
one summary field. Aggregate queries can create 
group summaries using a wide variety of 

mathematical functions, so you can summarise the 
same field in several different ways, as well as 
summarising more than one field in the same 
query. 

2 

5 

8 
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MODIFYING AGGREGATION HEADINGS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Aggregate 
Queries_4.accdb... 

 
Open the query 
Expenses Statistics in 
Design View 

 
In the field list, click to the 
left of the first Amount 
and type Total: then 

press  to move to the 
next field 

 
Repeat step 2 and add 
the following text to the 
remaining aggregation 
Amounts: 

Count Number: 
Avg Average: 
Max Maximum: 

 
Save the changes, then 
run the query to display 
the modified headings 

 
Close the query 

 

When you create aggregate queries, names are 
automatically assigned to the headings. Access 
uses a combination of the field name and the 
aggregate function, resulting in names like 

SumOfAmount, AvgOfAmount, and MaxOfAmount. 
Fortunately, you can modify the headings to 
provide something more descriptive and 
meaningful for your users. 

2 

3 

For Your Reference… 

To modify aggregation headings: 

 In query Design View, click in the Field cell 
and type the new name before the field 
name, followed by a colon e.g. 
Total:[Amount] 

4 

Handy to Know… 

 When you double-click on the border 
between headings in a displayed query, it 
automatically sizes the columns to fit the 
data displayed in the query. You can do the 
same in the query grid to check detailed 
criteria or to display more fields at once. 
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AGGREGATING CALCULATED FIELDS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Access lets you aggregate calculated fields. 
Calculated fields are fields that have been 
created in the query. For example, in an invoice 
application you might create a Totals field by 

multiplying the Quantity and the Price fields. Once 
created, a calculated field becomes like any other 
field and can therefore be aggregated to create a 
summary figure. 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file Aggregate 
Queries_5.accdb... 

 
Open the query Expenses 
Summary in Design View 

 
Click in the first available 
blank Field cell and type 
Tax:[Amount]/11 then press 

 to move to the next field 

 
Type Net 
Amount:[Amount]-
([Amount]/11) 

 
Click on the Group By cell 
for Tax, click on the drop 
arrow, then select Sum  

 
On the Query Tools: Design 
tab, click on Property Sheet 
in the Show/Hide group to 
display the Property Sheet 

 
Click in Format, then click on 
the drop arrow and click on 
Currency 

 
Repeat steps 4 to 6 for the 
Net Amount field 

 
Close the Property Sheet 
pane, then save and run the 
query 

 
Close the query 

 

2 

3 

6 

For Your Reference… 

To aggregate calculated fields: 

1. Create a calculated field 

2. Click in the Total row of the calculated field 
and select an appropriate aggregation 

operation (e.g. Sum, Avg, Count, etc) 

Handy to Know… 

 You can create calculated fields that use 
aggregation functions. Change the Total row 
for a field to Expression, then type an 
expression in the Field row that uses 

aggregate functions e.g. Sum([Amount]). 

8 
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APPLYING CRITERIA TO AGGREGATES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Aggregate 
Queries_6.accdb... 

 
Double-click on 
Expenses Summary to 
see a summary of 
expense transactions 

 
On the Home tab, click 
on the top half of View 
in the Views group to 
switch to Design View 

 
Click in the Criteria cell 
for Amount and type 
>5000 

 
On the Query Tools: 
Design tab, click on 
Run in the Results 
group, to see only 
summaries that have a 
total greater than 5000 

 
On the Home tab, click 
on the top half of View 
in the Views group, to 
return to Design View 
and try the criteria as 
shown – clear the 
previous criteria before 
trying each 

 
Close the query – click 
on [No] to discard the 
changes 

 

An aggregate query has many of the same 
attributes as a standard select query including 
the ability to be able to apply criteria to the 
aggregation. This is useful when you want to 

select and aggregate specific records. For 
example, you could create an aggregate query that 
calculates the expenses for a department which 
has been specified by the user via a parameter.  

1 

3 

For Your Reference… 

To apply criteria to aggregation queries: 

1. In Design View, click in the appropriate 
Criteria cell and type the criteria 

2. On the Query Tools: Design tab, click on 
Run in the Results group 

Handy to Know… 

 When applying criteria to aggregate queries, 
the criteria can either be fixed or involve a 
parameter, like [Enter the Description], so 
that the user can provide the information 
each time the query runs. 

Field Criteria 

Description Accommodation A 

Description Accom* 

Department “Sales & Marketing” 

 

4 

5 
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UNDERSTANDING NESTED QUERIES 
 

 

 

 

 

 

Sometimes the scope of what you are trying to 
achieve with your queries is just too much for one 
query to handle. Sometimes you may be able to 
achieve very difficult operations but because of 

the complexity of expressions, the whole thing 
becomes difficult to interpret later on. When this 
occurs you should consider nesting queries where 
one query calls on another to produce results. 

Queries That Use Queries 

Normally when you create a new query you choose one or more tables upon which to base the 
query design. This is done through the Show Table dialog box. 

However, the Show Table dialog box has a tab specifically for queries, where you can base your 
new query not on a table but on a pre-existing query in the database. When a new query is based on 
an existing query the process is referred to as nesting queries. 

In our case study database we want to be able to produce a summary of transactions by transaction 
type, showing both net of tax and tax inclusive amounts, for a range of dates that can be specified by 
the user when the query is run. This will involve: 

 the creation of calculated fields for tax, and net of tax amounts 

 the use of parameters to allow the user to choose a date range 

 the aggregation of the amounts. 

If we tried to create this in one aggregation query we would end up with two Group By fields: one for 
the date and the other for the type of transaction. While we might be able to achieve this with 
convoluted expressions and criteria, we are better off creating two distinctly different queries: 

 the first to calculate the tax and net of tax amounts and to provide the parameters where the user 
can specify a date range 

 the second to aggregate the data from the first query into totals. 

The Assembly Query 

The first query is usually where the majority of the work takes place and the raw data is assembled 
for further manipulation in the next query. The first query is known as an assembly query because 
the appropriate data is gathered, assembled, and extracted ready to pass on to the next query. 

This query normally has: 

 one or more related tables, forming the basis of the field listings 

 calculated fields based on the fields from the tables 

 parameters to allow the user to choose a data range. 

The Nesting Query 

The nesting query uses the assembly query rather than tables from the database. This allows 
further manipulation of the data in the desired result. Nesting queries are used either because it 
would not be possible to place all of the manipulations into one query, or because to do so would 
require too high a level of complexity in expressions, criteria, parameters, formulas, and the like. 

It is the nesting query that is used to display the final, desired results. When a nested query is run it 
first runs the assembly query upon which it is based. All of the necessary calculations and 
machinations from the assembly query are placed into a temporary dynaset (kind of like a results 
table), which then becomes the source data for the nesting query to further manipulate. 

You can also run the assembly query as you would any other query, but it will stop when it has done 
its work as there is no direct two-way link between it and the nesting query. 
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CREATING AN ASSEMBLY QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file Aggregate 
Queries_7.accdb... 

 
Click on the Create tab, then 
click on Query Design in the 
Queries group 

 
Double-click on Expense 
Transactions and Expense 
Type, then click on [Close] 

 
Double-click on the fields as 
shown, to place them in the 
grid 

 
Create two new calculation 
fields as shown 

 
On the Query Tools: Design 
tab, click on Property Sheet 
in the Show/Hide group, 
then format the calculated 
fields as Currency 

 
Click in the Criteria cell for 
ExpDate and type Between 
[Enter Start Date] and 
[Enter End Date] 

 
Save the query as Expenses 
(exTax) 

 
Close the query – try running 
the query using 1/3/15 and 
31/3/15 as parameters 

 

For Your Reference… 

To create an assembly query: 

 Create a new query incorporating fields, 
calculated fields, and parameters as required 

Handy to Know… 

 You can use an assembly query for nested 
queries or as a standalone query. It does not 
have any formal links to a nested query. 
Even when the assembly query is used by a 
nested query there is no link within the 
assembly query to the nesting – all of the 
links are in the nested query. 

When creating a nested query scenario the first 
query is usually where most of the manipulation 
and calculations take place. The first query, 
which we’ll refer to as the assembly query, 

usually utilises data from one or more tables and 
may include calculated fields and even parameters, 
allowing the user more choice in the data content. 

Table Field 

Expense Transactions ExpDate 

Expense Type Description 

Expense Transactions Amount 

 

3 

Tax: [Amount] – ([Amount]/1.1) 

and 

Net Amount: [Amount]/1.1 

4 

6 
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CREATING THE NESTING QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
il
e
 Continue using the 

previous file with this 
exercise, or open the file 
Aggregate 
Queries_8.accdb... 

 
Click on the Create tab, 
then click on Query Design 
in the Queries group to 
display the Show Table 
dialog box 

 
Click on the Queries tab to 
see the list of queries 

 
Double-click on Expenses 
(exTax), then click on 
[Close] 

 
Double-click on 
Description, Amount, Tax 
and Net Amount to add 
them to the query grid 

 
On the Query Tools: 
Design tab, click on Totals 
in the Show/Hide group, 
then change the Group By 
operation for Amount, Tax 
and Net Amount to Sum 

 
Save the query as 
Expenses Summary 
(exTax) 

 
Run the query and use 
1/3/15 and 31/3/15 as the 
parameters 

 
Close the query 

 

For Your Reference… 

To create a nesting query: 

1. Click on the Create tab, then click on Query 
Design in the Queries group 

2. Click on the Queries tab of the Show Table 
dialog box and select the query 

3. Add fields, etc. as normal 

A nesting query is one that uses a query as a 
data source rather than a table. Nesting queries 
are often relatively sparse as much of the real 
work has been done in the assembly query. 

Nesting queries therefore often perform specialised 
operations such as aggregating data that has been 
pre-prepared in the assembly query. 

2 

Handy to Know… 

 Formatting stays with the query in which it 
was created. You will need to re-format data 
in a nesting query even though it may have 
been previously formatted in the assembly 
query. 

5 

7 
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CHAPTER 6 ACTION QUERIES 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this session you will: 

 learn how to create a Make Table query 

 learn how to run a Make Table query 

 gain an understanding of using expressions in Update 
Queries 

 learn how to create an Update Query 

 learn how to run an Update Query and change data 

 learn how to use an expression to update records in an 
Update Query 

 learn how to run an Update Query that is based on an 
expression 

 learn how to create a Delete query 

 learn how to run a Delete query 

 learn how to create an Append query 

 learn how to run an Append query 

 learn how to turn action messages off. 

Action queries are used to make large scale changes to the data 
in one or more tables. There are four action queries available for 
use. 

 Make Table queries allow you to create a new table from an 
existing table or query. This type of query is ideal for 
archiving old data or making backup copies. 

 Update queries allow you to update data in existing tables. A 
classic use is to perform a large-scale update of pay scales 
or prices. For example, if you need to add a 10% sales tax to 
a range of products, you can use an Update query to 
increment the current prices by 10%. 

 Append queries allow you to add records from one table to 
another. For example, if you need to consolidate the sales of 
several salespeople, you can use an Append query to 
append the records from the sales people into one table. 

 Delete queries allow you to delete records based on criteria. 
For example, you can use a Delete query to delete all sales 
records that are more than 12 months old. 

INFOCUS 
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CREATING A MAKE TABLE QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
p

e
n

 

F
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e
 Before starting this exercise 

you MUST open the file 
Action Queries_1.accdb... 

 
On the Create tab, click on 
Query Design in the 
Queries group to display the 
Show Table dialog box 

 
Double-click on Expense 
Transactions, then click on 
[Close] 

 
Double-click on the asterisk 
to add all fields to the query 
grid, then double-click on 
ExpDate to add a copy of 
this field 

 
Click in the Criteria cell for 
ExpDate , then type 
Between [Enter Start Date] 
and [Enter End Date] and 
click on Show so it appears 
without a tick 

 
On the Query Tools: Design 
tab, click on Make Table in 
the Query Type group to 
display the Make Table 
dialog box 

 
Type Monthly Expenses in 
Table Name, then click on 
[OK] 

 
Click on Save, type Make 
Monthly Expenses Table, 
then click on [OK] 

 
Close the query 

 

For Your Reference… 

To create a Make Table query: 

1. Create a new query, specifying the fields you 
want in the table 

2. On the Query Tools: Design tab, click on 
Make Table in the Query Type group and 
give the output table a name 

As the name suggests a Make Table query 
creates a new table from existing data. You can 
use a Make Table query to export records to 
another database, to start an archive table for 

redundant records, to export related information 
from several tables to Excel or Word, or to create a 
smaller single entity recordset from a large, related 
recordset to facilitate further analysis. 

3 
Double-click on the asterisk to add 

all fields to the query grid… 

4 

5 

Handy to Know… 

 Access doesn’t allow duplicate fields when a 

Make Table query is run. 

The idea with these settings is to create a Make Table query that 
can be used repeatedly. Let’s say we need to produce a list of 
transactions on a monthly basis. With the query above, we could 
run it monthly, specify the dates that we are interested in, and 
only those transactions that match the dates will be outputted 
into the new table called Monthly Expenses. We could then 
perform further analysis, produce reports and do whatever we 
like with this table without fear of corrupting the data in the 
original transactions table. 
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USING A MAKE TABLE QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
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e
 

Continue using the previous 
file with this exercise, or 
open the file Action 
Queries_2.accdb... 

 
Double-click on the query 
Make Monthly Expenses 
Table to run it 

A message advises that you 
are about to run a Make 
Table query… 

 
Click on [Yes] to proceed 
and display the first 
parameter prompt 

 
Type 1/3/15, then click on 
[OK] to display the second 
prompt 

 
Type 31/3/16, then click on 
[OK] 

A message advises that you 
are about to paste records 
into a table… 

 
Click on [Yes] to create a 
new table called Monthly 
Expenses 

 
Double-click on the table 
Monthly Expenses and 
spend a few moments 
examining the data 

 
Close the table 

 

When you run a Make Table query it actually 
creates a new table of data based on the 
parameters and criteria that you have specified in 
the query design. The new table can then be 

used as any other table in your database and can 
be exported, queried and reported on as you see 
fit. Each time you run the query the table is 
re-created with the latest data. 

1 

2 3 

4 

For Your Reference… 

To run a Make Table query: 

1. Double-click on the Make Table query in the 
Navigation pane 

2. Click on [Yes] 

3. Continue to follow the prompts 

Handy to Know… 

 If you have already run the make table query 
and created a new table, that table will be 
deleted and replaced each time the query is 
run. 

6 
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UNDERSTANDING EXPRESSIONS AND UPDATE QUERIES 
 

 

 

 

 

 

Expressions are used throughout Microsoft 
Access for a variety of purposes, such as setting 
properties, creating parameters, defining 
calculated controls in forms and reports, defining 

calculated fields in queries, and setting validation 
rules. They are also essential in Update queries 
because they define the changes to be made to the 
records. They are discussed in more detail below. 

What is an Expression? 

An expression is a combination of symbols – identifiers, operators, and values – that produce a 
result. For example, you can use the following expression in a control on a form or report to display 
the sum of values in the Subtotal and Freight controls: = [Subtotal] + [Freight]. 

Expressions and Update Queries 

Expressions are used in Update Queries to modify the value in a particular field for each record.  
For example, if you wanted to increase the price of all of your products by 3%, you could modify 
each record manually, or you could create an Update Query to do the job for you. If the field that 
held the price was called [UnitPrice], you would use the expression [UnitPrice]*1.03 in the Update 
Query. When the Update Query was run, Access would take the existing value in UnitPrice in each 
record, and replace it with a value that was 3% higher. 

Examples of Expressions 

Update expressions are entered in a special Update To row that appears in the query grid. The 
following table lists some examples of expressions and describes how they would work in an update 
query. 
 

Field Type Expression Effect in an Update Query 

Currency [Quantity]*[Price] Multiplies the value in the Quantity field by the 
value in the Price field to calculate the cost for 
each record 

Currency [Salary]*1.05 Increases the Salary for each record by 5% 

Currency DSum(“[Quantity]*[UnitPrice]”,”Order 
Details”,”[ProductID]=” & [ProductID]) 

Where the Product IDs in the current table 
match the Product IDs in the Order Details table, 
updates the sales totals based on the product of 
Quantity and UnitPrice 

Short Text [LastName] & “, “ & [FirstName] Joins the LastName and the FirstName fields 

together, separating them with a comma so that 
John Smith will appear as: Smith, John 

Short Text “Salesperson” Changes value to Salesperson 

Yes/No Yes Changes all of the records to True (Yes) 

Date #1/1/2010# Changes all of the dates to January 1 2010 

Date [Due]+30 Adds 30 days to the current Due date 

Testing Expressions 

Given that you can use expressions to create calculated fields, you may like to create an interim 
select query to test that your expression gives the result you expect. Use the expression to create a 
calculated field in a select query on the table you want to update. Examine a good sample of the 
results to make sure the calculation is working as expected. You can then transfer your calculation to 
the update query, and make the changes required. 



Microsoft Access 2016 - Advanced Queries 

© 2017 The University of Nottingham Page 53 Chapter 6 - Action Queries 

PREPARING AN UPDATE QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

An Update query allows you to update the data 
in a table. You can update the data in one or 
more fields and even in one or more tables at 
once. You can also elect to update only some of 

the records in a table. The first step is to create a 
select query that lists the records and fields you 
want to update. In this example, we will update a 
field in Expense Transactions. 

Try This Yourself: 

O
p

e
n

 

F
il

e
 Before starting this exercise 

you MUST open the file 
Action Queries_3.accdb... 

 
Click on the Create tab, then 
click on Query Design in the 
Queries group 

 
Double-click on Expense 
Transactions, then click on 
[Close] 

 
Double-click on ExpDate, 
Expense Type, Amount 
and Processed 

 
Click in the Criteria cell for 
ExpDate and type [Enter 
the processing date] 

 
On the Query Tools: 
Design tab, click on Update 
in the Query Type group 
and notice how the Sort row 
changes to Update To 

 
Click in the Update To cell 
for Processed and type Yes 

 
Click on Save, type 
Processing Completed, 
then click on [OK] 

 
Close the query 

 

3 

4 

For Your Reference… 

To create an Update Query: 

1. Create a new query, specifying the fields you 
want in the table 

2. On the Query Tools: Design tab, click on 
Update in the Query Type group, then enter 

a value/expression in Update To 

Handy to Know… 

 In an Update Query you can enter a value 
directly into an Update To cell if the field only 
accepts true/false or yes/no values. If dealing 
with dates or numeric values, you would 
most likely have to create an expression to 
perform a calculation. 

6 

In our case study, expense transactions are processed on a daily 
basis – this involves examining the claim and passing it on to the 
employee’s manager for approval. 

In the update query, we want a logical field (called Processed) in our 
Expense Transactions table to be updated to reflect that transaction 
records have been processed. We could do this manually by simply 
editing each record but that’s very time-consuming. Since 
transactions in our case study are processed daily, we want the 
query to prompt for a date and, when the date is supplied, we want 
the update query to mark all of the records for that date as 
“processed” by placing a “Yes” in the Processed field. 
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RUNNING AN UPDATE QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 F
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e
 Continue using the 

previous file with this 
exercise, or open the file 
Action 
Queries_4.accdb... 

 
Double-click on the 
query Processing 
Completed to run it 

Since this is an update 
query you will be notified 
that data may be 
modified… 

 
Click on [Yes] – the 
parameter box will 
appear requesting a 
processing date 

 
Type 2/1/15, then click 
on [OK] 

You will now be advised 
of the number of records 
that will be updated… 

 
Click on [Yes] to 
perform the update 

 
Double-click on 
Expense Transactions 
to open the table – all 
records for 2/1/15 
should show a tick in the 
Processed field 

 
Close the query 

 

Update queries are used to update records in 
tables. In our case study some employees are 
authorised to claim their expenses back through 
their pay. The Update query that we’ve created 

will update transactions and mark them as 
processed. It does this by prompting for the 
transaction date and then marking the Processed 
field for all records found for this date. 

1 

2 

3 

For Your Reference… 

To run an Update query: 

1. Double-click on the update query in the 
Navigation pane 

2. Click on [Yes] 

3. Continue to follow the prompts 

Handy to Know… 

 When running update queries where a lot of 
data is updated, it may be handy to also 
create a sibling update query that reverses 
the changes. 

5 
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UPDATING USING EXPRESSIONS 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e
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e
 

Continue using the 
previous file with this 
exercise, or open the file 
Action Queries_5.accdb... 

 
Click on the Create tab, 
then click on Query 
Design in the Queries 
group 

 
Double-click on 
Employees and Personal 
Details, then click on 
[Close] 

 
Double-click on LastName 
and Salary to add these 
fields to the grid 

 
Click in the Criteria cell for 
LastName and type [Last 
name of employee:] 

 
On the Query Tools: 
Design tab, click on 
Update in the Query Type 
group to display the 
Update To row 

 
Click in the Update To cell 
for Salary and type 
[Employees.Salary] * 
((1+ [Percentage 
Increase] / 100 )) 

 
Click on Save, type Salary 
Increase, then click on 
[OK] 

 
Close the query 

 

Expressions can be used in the Update To cell 
of an Update Query rather than using 
hard-coded values. Expressions are often used 
to increment or decrement a date or a numeric 

value. For example, you can update the pay date to 
the next date the pays are processed, give your 
employees a 5% pay rise, and more by using 
expressions. 

3 

4 

5 

For Your Reference… 

To use an expression to update records: 

1. Create a new query, specifying the fields you 
want in the table 

2. On the Query Tools: Design tab, click on 
Update in the Query Type group, then enter 

an expression in the Update To cell 

Handy to Know… 

 Expressions can be tricky to create in update 
queries and you should take care before 
running the query, ensuring that you have a 
backup of the original data. 

In this query a parameter is used to prompt for the LastName of 
the employee to update. A second parameter within the 
expression is then used to capture the percentage increase that 
will be made to the employee’s salary. 

For example, if the user types 5, the salary will be increased by 
5% – the formula to do this reads “take the current salary [Salary] 
and multiply it by 1, plus whatever the user specifies as 
[Percentage Increase] divided by 100”. 

If the user types 5, meaning 5%, this formula will be: 

[Salary] * 1.05. 
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RUNNING AN EXPRESSION-BASED UPDATE 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
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e
 

Continue using the previous 
file with this exercise, or 
open the file Action 
Queries_6.accdb... 

 
Double-click on the query 
Salary Increase to run it – 
you will receive a warning 
that an update will occur 

 
Click on [Yes] – the first 
parameter prompt 
requesting the amount of 
increase appears 

 
Type 7 (i.e. 7%), then click 
on [OK] to display the 
prompt for the employee’s 
name 

 
Type Millson, then click on 
[OK] 

Access will now advise that 
one record will be 
updated… 

 
Click on [Yes] to perform 
the update 

 
Double-click on the query 
Employee Data Entry, click 
on the record for Millson 
(#107), then scroll right to 
see how the salary shows 
$90,950 –  an increase of 
7% over $85,000 

 
Close the query 

 

For Your Reference… 

To run an expression-based update query: 

1. Double-click on the name of the query in the 
Navigation pane 

2. Follow the prompts 

Running an update query based on an 
expression is no different to running any other 
update query. The only real difference is in 
determining what changes have been made and 

where they have occurred. Expression-based 
updates are usually more subtle than their full-
replacement siblings so you really need to know 
your data before running an expression update. 

1 

2 3 

4 

Handy to Know… 

 When using parameters in an update query, 
be sure to use one or more fields with unique 
results to indicate specific records or you 
might update more records than intended. 

6 
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CREATING A DELETE QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
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Continue using the previous 
file with this exercise, or open 
the file Action 
Queries_7.accdb... 

 
Click on the Create tab, then 
click on Query Design in the 
Queries group 

 
Double-click on the Expense 
Transactions table, then click 
on [Close] 

 
Double-click on ExpDate and 
Processed to place these 
fields into the query grid 

 
Click in the Criteria cell for 
ExpDate and type <=[Delete 
processed records on or 
earlier than] 

 
Click in the Criteria cell for 
Processed and type Yes 

 
On the Query Tools: Design 
tab, click on Delete in the 
Query Type group to change 
the Sort row to a Delete row 

 
Click on Save, then type 
Delete Processed 
Transactions, then click on 
[OK] 

 
Close the query 

 

For Your Reference… 

To create a delete query: 

1. Create a new query, specifying the fields you 
want in the table and criteria for record 
selection 

2. On the Query Tools: Design tab, click on 

Delete in the Query Type group 

As its name suggests, the Delete query is used to 
delete records from a table. The deletion is based 
on criteria in the query grid – any record that 
matches the criteria will be deleted. Be careful 

though – if you have enforced referential integrity 
and Cascade Delete Related Records is ticked, 
Access will delete matching records in any related 
table even if it is not included in the query. 

4 

6 

Handy to Know… 

 Before changing a query to a delete query, 
run it as a select query and check which 
records will be deleted. Once deleted, 
records cannot be recovered, except from a 
backup file. 
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RUNNING A DELETE QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Delete queries are potentially very dangerous 
queries as they will delete data from your 
database. While we won’t do it here, some 
precautions you should take before running a 

delete query include making a full backup of your 
database file and also running a Select query with 
the same criteria to see exactly what records will be 
deleted by the Delete query when it is run. 

Try This Yourself: 

S
a

m
e

 

F
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e
 

Continue using the previous 
file with this exercise, or 
open the file Action 
Queries_8.accdb... 

 
Double-click on the query 
Delete Processed 
Transactions to run it – a 
warning message indicates 
that data will be changed 

 
Click on [Yes] to display the 
transaction date prompt 

 
Type 2/1/15, then click on 
[OK] 

The number of records 
flagged for deletion will be 
displayed in a final prompt… 

 
Click on [Yes] to delete the 
records 

 
Double-click on the table 
Expense Transactions and 
notice that there are no 
records for 2/1/2015 

 
Close the table 

 

1 

2 

3 

For Your Reference… 

To run a delete query: 

1. Double-click on the delete query in the 
Navigation pane 

2. Follow the prompts 

Handy to Know… 

 Delete queries are often used in conjunction 
with Make Table queries where the data that 
would be deleted is first put into a new table 
as an archive. 
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CREATING AN APPEND QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

O
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F
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 Before starting this exercise 

you MUST open the file 
Action Queries_9.accdb... 

 
Click on the Create tab, 
then click on Query Design 
in the Queries group 

 
Double-click on the 
Expense Transactions 
table, then click on [Close] 

 
Double-click on each of the 
fields to place them all in 
the query grid 

 
Click in the Criteria cell for 
ExpDate and type 
Between [Enter the start 
date] And [Enter the end 
date] 

 
On the Query Tools: 
Design tab, click on 
Append in the Query Type 
group to display the 
Append dialog box 

 
Click on the drop arrow for 
Table Name, select 
Transactions Archive, 
then click on [OK] 

 
Click on Save, then type 
Transactions Backup and 
click on [OK] 

 
Close the query 

 

For Your Reference… 

To create an append query: 

1. Create a query design using all of the fields 
from the source table and add the criteria 

2. On the Query Tools: Design tab, click on 
Append in the Query Type group, then 
nominate the target table 

An Append query allows you to add records from 
one table into another. The table that holds the 
records you want to add is known as the source 
table. The table that you want to add them to is 

the target table. The first step is to create a query 
in the source table and select the records you want 
to append. You then convert it to an Append query 
and nominate the target table. 

4 

5 

Handy to Know… 

 An Append query is similar in operation to a 
Make Table query except that instead of 
re-creating a new table each time it is run, it 
simply adds (i.e. appends) the specified 
records from the source table to the 
nominated target table. 

6 
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RUNNING AN APPEND QUERY 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Try This Yourself: 

S
a

m
e

 

F
il

e
 

Continue using the previous 
file with this exercise, or open 
the file Action 
Queries_10.accdb... 

 
Double-click on the query 
Transactions Backup to 
display a warning about 
changing data in the 
database 

 
Click on [Yes] to display the 
prompt for a start date 

 
Type 1/1/15, then click on 
[OK] to display the prompt for 
the end date 

 
Type 31/1/15, then click on 
[OK] 

You will now be advised how 
many records will be 
appended to the target 
table… 

 
Click on [Yes] 

 
Double-click on the table 
Transactions Archive to 
display the records 

 
Close the table 

 

An Append query is run from the Navigation 
pane the same as any other form of query or 
action query. You must, however, ensure that the 
nominated target table in the Append query 

exists otherwise you will receive an error. Also, you 
can’t run the Append query more than once 
because by adding the same records again you will 
be violating data integrity rules. 

1 

2 

3 

4 

For Your Reference… 

To run an append query: 

1. Double-click on the query in the Navigation 
pane 

2. Follow the prompts 

Handy to Know… 

 The target table must exist prior to running 
the Append query. This will most likely be 
the case because the target table is selected 
from a list in the Query Design. However, 
take care not to delete or modify the target 
table before running an Append query. 
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TURNING ACTION MESSAGES OFF 
 

 

 

 

 

 

By default, Microsoft Access displays two 
messages when performing action-based 
queries. The first appears when the query is first 
run and warns that data is about to be modified. 

The second appears just before the action is 
performed and advises how many records will 
change. These are known as action messages 
and can be turned off if desired. 

The Steps to Turn Action Messages Off 

Action messages can be turned off using a tick box found within the Client Settings category in the 
Access Options dialog box. 

To turn action messages off, the Action queries option needs to appear without a tick. This is done 
using the following procedure: 

1. Click on the File tab to display the Backstage 

2. Click on Options to display the Access Options dialog box 

3. Click on the Client Settings category in the list on the left 

4. Scroll down until you can see Action queries in Confirm, under the Editing heading 

5. Click on the tick box until the option appears without a tick 

6. Click on [OK] 

Repeating the above steps and placing a tick back into the box will turn the action warnings back on. 

NOTE: Turning action warnings on and off is a system-wide setting. This means that the setting is 
made for all of Microsoft Access irrespective of which database you are currently working on. 
Switching action messages off in a classroom environment can cause confusion, so that is why we 
have provided the above steps for reference only. 
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NOTES: 
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CONCLUDING REMARKS 

 

 

 

 

 

 

 

 

Congratulations!  

You have now completed Microsoft Access 2016 - Advanced Queries. Microsoft Access 2016 - 
Advanced Queries was designed to get you to the point where you can competently perform a 
variety of operations.  

We have tried to build up your skills and knowledge by having you work through specific tasks. 
The step by step approach will serve as a reference for you when you need to repeat a task. 

 

Where To From Here? 

The following is a little advice about what to do next: 

 Spend some time playing with what you have learnt. You should reinforce the skills that you 
have acquired and use some of the application's commands. This will test just how much of 
the concepts and features have stuck! Don't try a big task just yet if you can avoid it - small 
is a good way to start. 

 Some aspects of the course may now be a little vague. Go over some of the points that you 
may be unclear about. Use the examples and exercises in these notes and have another go 
- these step-by-step notes were designed to help you in the classroom and in the work 
place! 

Here are a few techniques and strategies that we've found handy for learning more about 
technology: 

 read computer magazines - there are often useful articles about specific techniques 

 if you have the skills and facilities browse the Internet, specifically the technical pages of 
the application that you have just learnt 

 take an interest in what your work colleagues have done and how they did it - we don't 
suggest that you plagiarise but you can certainly learn from the techniques of others 

 if your software came with a manual (which is rare nowadays) spend a bit of time each day 
reading a few pages. Then try the techniques out straight away - over a period of time 
you'll learn a lot this way 

 and of course, there are also more courses and books for you to work through. 

Hungry for More? 

We live in an ever-changing world where we all need to review and upgrade our 
skills. 

If you have received this course book on a training course why not ask the tutor or 
trainer for other courses that may be of benefit to you. If you are attending a 
college ask for one of their brochures. 

Alternatively, if you’ve enjoyed using this course book you can find others that 
cover a wide range of topics at our web site www.watsoniapublishing.com. 

 

http://www.watsoniapublishing.com/
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